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User management
Creating users
The first method used to create users consists of using a wizard. This creates the identifiers (badges, transmitters,

application badges, etc.), the users (persons that can access the site) and the access groups (rights and times of
access to various site readers).

8~

The following wizard is displayed:

then on the menu “Create users”.

To do this, click on

Identifiers issuance (Tags, transmiters,...)

@ Manual enter
7 Generate andom codes

(7 Self leaming (Strip your ldentfiers on a reader)

First number:

B Jaad]
Quantity:

1 1%
Type:

| Prox tag - |
Status:

[In use = |

e (o ] |

Enter your identifiers in one of three ways:
- By manual entry: enter the first identifier number and the amount to be created
- Generate random codes: the software will assign codes randomly
- By the ‘Self learning’ function: click on “Self learning” and then pass your identifiers one by one through any
reader in your installation or use an OMNIKEY reader.
Then select the type of identifier to be created (Proximity badge, Application badge, Transmitters or Codes) and the
status of these identifiers (In service, Suspended or Stolen).
Then click on “Next”.

Access rights

@ Use an existing group Managers " [ Show the group

7 Allow on all readers

(71 Allow on following readers

| Previws | [ Med || Cancel | |

Enter the access rights for the users to be created (authorisations for the various readers on site).
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To do this, you can:

Use an existing access group (note, this option is only available if there are already groups created in your
installation)

Authorise the users for all readers

Authorise the users for a selection of readers: The list of readers appears next and you must check the
readers the users can access.

Then click on “Next”:

.
Access time
(@ Pemanent access on all readers
"1 |dentical schedules on each reader
(. Different schedules on each reader
[ Previous | [ MNext ] | Cancel |

Enter the access times for your new users. To do this, you can:

Use the times of the selected access group: if you have chosen to use an existing access group, your only
option will be to use the times for this group

Do not limit the access times for your users

Define identical access times for all readers: to do this select or create a time slot

Configure different times for each reader: to do this, opposite each reader, select a time slot

Then click on “Next”:

Allowance

Status:
[Alowed -

[7] Alarm management

[T] Without cycle test

7] Relauching Anti-Passback

[ Limit number of passages to: 1
[ Validity dates

Previous ‘[ Neat Jl Cancel

Enter the options for your users:

Their status (Authorised or Suspended)

The “Alarm Management” option: users authorised to enable/disable an alarm connected to the unit (your
installation must be properly configured for this beforehand)

The “Without cycle verification” option: if your installation is configured to use Anti-Pass-Back and this box is
checked, all of the users created with this option will not be subject to Anti-Pass-Back.

The “Relaunching Anti-PassBack” option: each time these users pass, all Anti-Pass-Back cycles for all users
will be erased (all users can once again re-enter or re-exit)

The dates and times of the start and end of the validity
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Then click on “Next”.

Confirmation

Create following Identffiers:

Type: Proxtag
S20CT4AA

Use of the Group:

Managers

[¥] Show a summary

Previous - Cancel

Check that all the information displayed is correct. If the wizard needs to create a new access group, you can change
its name. Then click on “Confirm” to finish creating your users.

Modifying a user

To modify a user, you must first open their information file.

S}JUM,

To find a user, from the menu , click on “Users”. The list of users will be displayed. Double click on
one of the users in the list, or click on then search for a user by surname, first name or identifier.

The user file is then displayed:

— —
Identty |Identfiers | Allowance | More information | Motions | Additional profil | Options | Printing |
Mame:
Dave
Given name:
Michaels
Add
Take a photo
Delete
Attendance
Uinknown - Last access at 07122011 11:25:24 [ oK J [ nd J

Useful information: At the bottom of the window, you will find information relating to your user’s presence
(Unknown if you don’t use Anti-Pass-Back at your site or if the user has still not presented him or herself at one of
the site readers, entry or exit, as well as the date and time of their last passage).

From the “Identity” tab, you can:

- Configure a surname and first name for your user
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- Add an image file already saved on your computer or network
- Take a photo using a webcam connected to your computer
- Delete the user photo

If you click on “Take a photo”, the following window is then displayed:

(Integrated Camer z) |

L) | R

[ ok | [ comcd |

Select the webcam to be used from the list at the top left. Click the “Capture” button to take the photo. Finally, if the
photo is acceptable, click on “OK”.

Identity | Identfiers | Alowance | More information | Mations | Addtional profi | Options | Prnting |

E il AFIGBEE Prox tag Inuse

Attendance

Unlknown - Last access at 07/12/2011 11:25:24 I

From the “Identifiers” tab, you can:

- Add new identifiers to your user (for example, your user can use a transmitter to access a car park and a
badge to access their office). You can add as many identifiers to a user as you want to (15,000 maximum).
Note, the same identifier cannot be added to multiple users. Click on the “Add” button. The list of identifiers
(only those not yet allocated) is then displayed; double click the identifier to be added to the user.

- Modify an identifier already allocated: select an identifier from the list and then click “Edit”. You can then
modify the identifier type (Proximity badge, etc.) and the status (In service, Suspended or Stolen).

- Delete an identifier from your user: select an identifier from the list and then click “Delete”.
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Identity | Idertifiers | Alowance | More information | Motions | Additionial profil | Options | Printing |
v] Access rghts

Status: [_n.umed

Groups

Time zone: [Gm_p zone v]

| Show the zone |

Validity dates
Activate

“B

Attendance

Unknown - Last access at 07/12/2011 11:25:24 [

ok || cancel

From the “Allowance” tab, you can:
Select the user status (In service or Suspended)
Configure their access times:

(0)
0)

(0]

Group time slot (use the times configured for the access group)
Permanent access: no restriction on access times for all readers despite any time slots configured for
the access groups

Time slot already created: use of these access times for all readers despite any time slots configured
for the access groups

Configure the dates and times of the start and end of the validity
Configure the access groups:

(0]

Add a group from those already created: Click on the “Add” button. The list of groups is then

displayed. Double click the access group to be added. You can add up to three access groups for the
same user

Modify the access group selected in the list
Delete the selected access group
Configure the usage priorities of the access groups by the units: select an access group and then click

the arrows and . The access group at the top of the list (preceded by the number 1) will
be used first and so on.
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| identity | Idertifiers | Alowance | Mere information | Motions | Additional profil | Options | Prnting |

Mo additionnal fields : use the "Tools" menu then "Favortes”, tab "Additionnal informations "r'n'\rin

Aftendance

Unknown - Last access at 07/12/2011 11:25:24

o) (Lo ]

From the “More information” tab, you can add other types of information to your user (e.g. telephone number,
parking place, email, etc.). To add new fields, go to the “Tools” menu then “Favourites”, tab “Additional information”
and add the desired fields.

| identiy | Identifiers | Alowance | More ifomation | Motions | Adcitioril profi | Options | Prnting |

|T|rne

D7N272017 11.25:24

07/12/2011 11:25:24

Main entrance

Warehouse door 1

07/12/2011 11:25:10

Warehouse door 1

07122011 11:25:07

Main entrance

07/12/2011 11:21:47

Main entrance

071272011 11:15:M

Main entrance

07/12/2011 11:17:32

Main entrance

071272011 11:16:54

Main entrance

07/12/2011 11:16:27

Warehouge door 1

071272011 11161

Main entrance

06/12/2011 16:14:35

Warehouse door 1

06/12/2011 16:14:15

Warehouse door 1

Ofgmsmndd ar g0 rd

Atendance

Unknown - Last access at 07/1272011 11:25:24

[ ok |[ Cancel |

From the “Motions” tab, you can display the last 50 passages by the user. The first line of the list corresponds to the

most recent passage.
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| Identity | Identfiers | Alowance | More information | Motions | Additional profil | Options | Panting |
A : h,t
Profil activation HECEES A0EE
Iﬂdive on time zone v] | Groups
Time zone:
[ Not defined -
(]
Status: INIowed - | ?l
Time zone: [Group zone - |
Show the zone
[T User escorted
| Add Edit Dielete
Attendance
I = I -y
Unknown - Last access at 07/12/2011 11:25:24 | T J | =

From the “Additional profil” tab, you can:
- Configure an additional profile for the user which will be active under the following circumstances:

(0]

O 0 O0Oo

(0}

Never (profile not used)

On a security level (if the software security level is the same as that selected)

On a minimum security level (If the software security level is greater than or equal to that selected)
On a time slot (when the selected time slot is active)

On a period (when the selected period is active)

Always active (this profile will always be used on each passage of the user)

- Configure the user authorisations when this profile is active:

(o}
(o}

(o}

(o}

Definition of the status (In service or Suspended)

Definition of the access times (use of the time slots for the access group of this profile, permanent
access or a selected time slot)

User escorted (if the user is normally escorted, check this box if you still want them to be
accompanied when this profile is active)

Access groups (identical to the access groups of the standard profile, you can add up to three access

groups).

Example of usage of an additional profile: During a period of the year (such as school holidays), you want to restrict
the access of the users. To do that, configure a list of days corresponding to the school holidays, select “Active for a
period), select the previously created list of days then allocate this more restricted access group to your users.
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|| Alam management | This user must be escorted
[™] No arti-passback checking
[7] Relauching Arti-Passback

[ Mumber of passers-by

[ Activate

Attendance

Unknown - Last access at 07/12/2011 11:25:24 |

OK || Cancel |

From the “Options” tab, you can modify the various options for your user:

- The “Alarm Management” option: users authorised to enable/disable an alarm system connected to the unit
(your installation must be properly configured for this beforehand)

- The “No Anti-PassBack checking” option: if your installation is configured to use Anti-PassBack and this box is
checked, all of the users created with this option will not be subject to Anti-PassBack.

- The “Relaunching Anti-PassBack” option: each time these users pass, all Anti-Pass-Back cycles for all users
will be erased (all users can once again re-enter or re-exit)

- The number of passages: The user will have a limited number of passes through readers configured to
manage this function

- The “This user must be escorted” option: On readers configured to manage this option, the user must be
accompanied by a specified user or a user belonging to an access group to be authorised.

[¥] This user must be escorted

Escort

@ User 71 Users group

Search | Delete

them:
0 “User”: click on “Search” then double click the person in the displayed list
0 “Users group”: click on “Search” then double click on the access group that can accompany them
(any user belonging to the selected access group can accompany the user)

Select this option and then choose the type of person to accompany

User listing

You can output user listings by setting the fields to be displayed and filtering them on various criteria.

e

-

To output a listing, from the menu, click on “Listing”. The following window will then be displayed:
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Queres Feats
Query:

= = [kAn | [LdEee |[ sectyme ][ dfe

R
Name: (Grven name: G Time aone. Stastun. Veldty st End of valkdty Ierters. Atendance: Ham Relaunching Golo Escorted

P
From this window, you can:
- Add a query: click on the “Add” button and then configure your query
- Modify a query: select your query from the list and then click on the “Edit” button.
- Delete a query: select your query from the list and then click on the “Delete” button.
- Execute a query: select your query from the list and then click on the “Run” button. The results will then be
displayed
- Export the results of a query: after having executed a request, select a format from the list (text file, comma-
separated text, Access 2007, Excel or XML database) and then click on the “Export” button
- Send the results of a query by e-mail: after having executed a query, select a format from the list (text file,
comma-separated text, Access 2007, Excel or XML database) and then click on the “Send by e-mail” button.
Select or enter a recipient and choose whether to compress the file or not. Note: to use this function, you
must have configured the mail parameters from the software “Favourites” menu.
- Print the results of a query: After having executed a query, click on the “Print” button.
- Open the selected user file by double clicking it or clicking the “Edit” button which appears at the bottom
right if the shortcuts are displayed (to display or hide the shortcuts, click the “Shortcuts” button)

Managing a query

Information

Wording: Al info

Display | Filters
View columns: Select al Unselect all

Date

Time

V] Type

/] Central
Reader

7] Identifier
[¥] Name
Given name
Group

St
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From the “Display” tab, you can:
- Give your query a name: enter in the “Wording” field
- Select the fields you want displayed in your listing
- Select a sort for the results

Information

Wording: New query E

| Dispiay | Fters |

Fileter by:

[] Name

[C] Given name

| [T] Time zone
[T Status

[T Validity start
[7] End of validity
[F] Atendance
] Alam

Filters:

Filter users
Regarding groups  Managers

0K | [ Cancel |

To filter the users to be displayed, click on the “Filters” tab. From this tab, you can define the following filters:
- By name: filter the users whose surname starts with / ends with / contains your text
- By first name: filter the users whose first name starts with / ends with / contains your text

- By group: filter the users whose group is in your list

- Bytime slot: filter the users whose time slot is in your list
- By status: filter the users who have the selected status

- By the validity start and end dates: filter the users whose validity dates are before / after / between the

date(s) entered

- By presence: filter the users who have the selected presence

- By the options Alarm, Relaunching, Pass (without verification of Anti-PassBack cycle), Escorted: filter the

users with these options selected

To add a filter, tick it in the list. A new window is then displayed allowing you to refine your search.
To modify a filter, from the list of filters (at the bottom of the window), click the blue link (example: MErEet ) a

new window is displayed allowing you to refine your search.
To delete a filter, simply unselect it.

For filtering by surname or first name, check the box “Ask on carrying out” and the program will ask you to enter the

text when you execute the query.

Once your filters are entered, click “OK” and then click “Run” in the preceding window. The results will then be

displayed.
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Management of time slots

el
17 Schedule and access rights |-
From the menu M , click on “Time zones”. The list of time zones is then displayed.
Click on “Add” to add a new time slot.

Click on “Edit” to modify the selected time slot.

Click on “Delete” to delete the selected time slot.

You can also enter the name of your time slot in the “Name” field to filter the time slots displayed.

Management of a time zones:

e — R
Wording Diizplay
Open doar zone 1 lNl days bl

Graphical erter | Manual enter]

5

th 2h 3h 4 5 6 7 8 S 10h 11h 12h 13 14h 150 16h 17h 181 1% 20h 21h 22 23h
Monday

Tuesday
Wednesday
Thursday
I
Frday
Saturday

Sunday

Bank holidays

1

1

Not defined |

ok |[ Gnesl |

From this window, you can:
- Edit the name of the time slot. Note: this name must be unique (multiple time slots cannot have the same
name).

- Configure the display type:
0 Every day: if your times are different each day
O Monday to Friday / weekend: if the times are identical during the week but different at weekends
0 Monday to Sunday if your times are identical from Monday to Sunday

- Enter your times
0 Graphicinput

Graphical enter | Manual enter @ 08:02 To 17:02

th th 2n 3 4 5 6 7 8 S 1bh 11h 12 13n 187 150 160 17h 18h 1% 20h 21h 2Zh 23

ere O S S T

Tuesday

=F

= Add atime slot: click in the red area, hold the left button down while dragging the cursor to
select the desired times

= Modification of a time slot: click on the time slot and move it. You can also double click on a
time slot then click “Apply” to manually enter the times
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Deleting a time slot: click on the time slot and then press the “Delete” key on your keyboard
or double click the time slot and then click the “Delete” button.
0 Manual entry:

Wording Display

Open door zone 1 [N days =

Graphical enter | Manual enter

| siot 1 Siot 2 Stot 3 Siot 4 Shot 5 Slot 6

»  Monday Frum 08:00 To 17:00

Tuesday From 05:00 To 22:00
Wednesday
Thursday

Friday
Saturday
Sunday

Bank holidays

] i |

]
Selected slot edition
From: 08:00 ks To: 17.00 [a)
e | ——

[ ok J[ Comce |

Add a time slot: click on an empty time slot, enter the times in the “Selected slot edition”
field, then click the “Apply” button

Modification of a time slot: click on the time slot to be modified, enter the new times in the
“Select slot edition” field, then click the “Apply” button

Deleting a time slot: click on the time slot to be deleted, then click the “Delete” button

For each time slot, you have the days of the week and a list of holidays. To configure this list, click the E] button
next to “Bank Holidays”. A new window is displayed where you can configure the list of holidays.
You can also create another list of specific days. To do this, click on “Add a list” in the drop-down list.

Bank holidays =

Not defined

Add a list

—
List 2

Configuration of Bank holidays

From the menulS = , click on “Bank holidays”. The list of holidays is then displayed.
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Select bank holidays Delete all days @ Mot renewable | Renewable ) Delete

December 2011 January 2012 February 2012
-Mon -Tue. .Wed. Thu .Fri Sat Sﬁn. ..I'u'lon. 'I;ue. Wed Thu Fn Sai. S.un | Mon. ;i;ue. Wed. 'I;hu. Fn. Sat Sun.
1 2 3 4 1 1 2 3 4 5

5 6 7 8 9 m n 2 3 4 5 & 7 8 6 il 12
12 13 14 15 f16 17 18 9 m n 12 13 14 15 13 14 15 16 7 18 13

~
[==]
]
=

m

19 20 21 2 23 M B B 17 SNk 19 20 2 22 2 A 2 23 | 4 2B X%
2% X B B 0 H 23 M B ¥ 27 B B 27 B B
Il A
March 2012 Aprl 2012 May 2012
| Mon. Tue. Wed. Thu. Fi. Sat.  Sum. | Mon. Tue.. Wed. Thu. Fi.  Sat. Sun. | Mom: Tue. Wed. Thu. Fi. Sat.  Sun
1 2 3 4 1 1 2 3 4 5 &

5 & 7 8 9 m N 2 3 4 B & o 8 7 B 3 m N 12 13
12 13 14 15 ik 17 18 9 nm 1" 12 13 4 15 14 15 A6 17 18 15 20

oW 21 2 B M B W 17 B8 2 2 2 2N 2 B M B XK
% 27 2 2/ 3N 3 2 24 25 % 2 B 29 28 29 N I

30 i

| ok || cancel

From this window, you can:

- Add repeating holidays (automatically repeated from one year to the next by the units and the program). To
do this, select “Renewable” then click the days you want to add. These days will turn to the selected colour.

- Add non-repeating holidays (automatically deleted when no longer valid). To do this, select “Not renewable
then click the days you want to add. These days will turn to the selected colour.

- Delete holidays: select “Delete” then click on each day to be deleted.

- Delete all holidays: click the “Delete all days” button

- Import holidays from Outlook: automatic import of holidays from your Outlook calendar. Note: to use this
function, Outlook 2007 must be installed on your computer.

”

Configuration of special days

As well as holidays, you can add up to eight lists of special days.
" :1 Schedule and access rights | =

From the

displayed.

Click on “Add” to add a new list of special days.

Click on “Edit” to modify the selected list.
Click on “Delete” to delete the selected list.

menu, click on “Special days”. The list of special days will then be
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Management of a list:

‘Wording
List 1 © Notrenewsble | Renewable ) Delete | Delete all days

Select bank holidays

December 2011 January 2012 February 2012
Mon. Tue. Wed. Thu, Fi. Sat. Sun. | Mon. Tue. Wed. Thu Fi Sat  Sun. | Mon. Tue Wed Thu Fi. Sat.  Sun.
¥ 2 F 4 1 1 2 3 4 5

5 m n 2 3 4 5 L 7 8 6 7 8 L) 10 1 12
12 13 14 15 16 17 18 3 m n 12 13 14 15 13 4 1 18 17 18 13
1/ A 2 23 24 B 16 7 18 13 20 2 22 2 2 2 13 MHM B B

en
™
-
(2]

% 7 2B ¥/ W I 2 M B ¥ 7 W AN ¥ B B
Y
March 2012 April 2012 May 2012
Mon. Tue. Wed. Thu. Fi. Sat. Sun. | Mon. Tue. Wed. Thu. Fi. Sat. Sun. | Mon. Tue. Wed. Thu. Fi. Sat. Sun.
' 2 % z | 1 i 2 B % & &
5 6 7 8 w M 2 3 4 5 €& 7 8 7 8 8 1 1 12 13

12 13 14 B 1% 17 18 3 m n" 12 13 14 15 14 B % 17 18 19 2
1\ 2 2 22 23 24 B 16 17 18 1B 20 2 22 21 2 23 M H X X
26 2Fr 28 29 M AN 23 M4 B X 27 248 2B 28 29 31 H

From this window, you can:
- Enter a name for your list in the “Wording” field
- Add, modify and delete days (same operation as for holidays)

Management of access groups

Ty
r el
17 Schedule and access rights |~

From the menu , click on “Access groups”. The list of groups is then displayed.
Click on “Add” to add a new group.

Click on “Edit” to modify the selected group.

Click on “Delete” to delete the selected group.

You can also enter the name of your group in the “Wording” field to filter the groups displayed.
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Management of an access group:

___ (S e~
Information | Allowance: | Schedule
Wording
Maragers
Group status

[ Forbid the group

|:| Maximum per group management

o) (o)

From the “Information” tab, you can:
- Configure the name of your access group
- Determine the status of your group: check the “Forbid the group” box to block all users belonging to this

group.
Information | Allowance | Schedule |
Forbidden readers: Allowed readers:
E L L =
Reader 2 Reader 4 Reader 5 Main entrance  Warehouse
door 1

e

Reader & @

ok || Cencel |

From the “Allowance” tab, you can select the readers the users are authorised for. Double click a reader in the left
list (list of forbidden readers) to allow it or double click on a reader in the right list (list of allowed readers) to forbid
it. You can also use the arrows between the two lists to toggle the selected readers.
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Information | Alowance | Schedule

@ Pemanent access on all readers
() Identical schedules on each reader
(71 Different schedules on each reader

From the “Schedule” tab, you can define the access time slots for the readers authorised for your group from the
following options:

- Do not limit the access times for your users

- Define identical access times for all readers: to do this, select or create a time slot

- Configure different times for each reader: to do this, select a time slot opposite each reader

Event management

Display events

You can display a list of events in real time at the bottom of your screen by clicking on the “View” menu, then on
“Events list”.

Date Type Reader Identifier MName Given name

Note: this list only contains events that have occurred since you started Visor. To close this list, click the “Close”
button at the top right of the list.

. .
To view the last 2000 events, click on the menu , then on “Show the list”.
The following window will then be displayed:
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o
SA122001 120212 PM

| 0/122011 176039 FM Uik Kareter
?!mn 123U mlﬂﬂ-

| S8R0 123648 P e sccacted

1558 Lited slemert )

From this window, you can:

View the last 2000 events
Double click an event concerning a user to open their file
Double click an event concerning an identifier to open their file

Event log

You can output an event log by setting the fields to be displayed and filtering them on various criteria.

l . ’
To output a log, from the menu

, click on “Log and reports”. The following window will then be

displayed:

1 Queres Rests I
Quory Mk = [pan | [dEpet | [ iSadoymet ][ e
Ty b LT —|

8Lt o )

From this window, you can:

Add a query: click on the “Add” button and then configure your query
Modify a query: select your query from the list and then click on the “Edit” button.
Delete a query: select your query from the list and then click on the “Delete” button.

Execute a query: select your query from the list and then click on the “Run” button. The results will then be
displayed
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- Export the results of a query: after having executed a query, select a format from the list (text file, comma-
separated text, Access 2007, Excel or XML database) and then click on the “Export” button

- Send the results of a query by e-mail: after having executed a query, select a format from the list (text file,
comma-separated text, Access 2007, Excel or XML database) and then click on the “Send by e-mail” button.
Select or enter a recipient and choose whether to compress the file or not. Note: to use this function, you
must have configured the mail parameters from the software “Favourites” menu.

- Print the results of a query: After having executed a query, click on the “Print” button.

- Ifthe selected event concerns a user, open their file by double clicking it or clicking the “Edit” button which
appears at the bottom right if the shortcuts are displayed (to display or hide the shortcuts, click the
“Shortcuts” button)

- Ifthe selected event concerns an identifier, open their file by double clicking it or clicking the “Edit” button
which appears at the bottom right if the shortcuts are displayed (to display or hide the shortcuts, click the
“Shortcuts” button)

Managing a request

Irformation

Wording: New guery 6

Depey [ |

View columns: Select al Unselect all

Given name
V] Group

Sort results by: [Date o

oK || Caneal

From the “Display” tab, you can:
- Give your query a name: enter into the “Wording” field
- Select the fields you want displayed in your log
- Select a sort for the results
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Information

Wording: New query &

Fileter by:

[7] Date

[7] Time

e |
[7] Central

[7] Reader

[ Identifier

[7] Name

[7] Given name

[ Group

Fiters:

Fiter events

Regarding types User accepted

To filter the evens to be displayed, click on the “Filters” tab. From this tab, you can define the following filters:
- By date: filter the events whose date is before / after / between the date(s) entered
- By time filter the events whose time is between the entered times
- By type: filter the events whose type is part of your list
- By central unit: filter the events whose central unit is part of your list
- By reader: filter the events whose reader is part of your list
- By identifier: filter the events whose identifier is part of your list
- By surname: filter the events whose surname starts with / ends with / contains your text
- By first name: filter the events whose first name starts with / ends with / contains your text
- By group: filter the events whose group is part of your list

To add a filter, tick it in the list. A new window is then displayed allowing you to refine your search.

To modify a filter, from the list of filters (at the bottom of the window), click the blue link (example: User sccepted ). A
new window is displayed allowing you to refine your search.

To delete a filter, simply unselect it.

For filtering by Surname or First name, check the box “Ask on carrying out” and the program will ask you to enter the
text when you execute the query.

Once your filters are entered, click “OK” and then click “Run” in the preceding window. The results will then be
displayed.
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